Systemic: A Testbed for Characterizing the Detection of Extrasolar Planets.

I. The Systemic Console Package

STEFANO MESCHIARI, AARON S. WOLF, EUGENIO RIVERA, GREGORY LAUGHLIN, STEVE VOGT, AND PAUL BUTLER

ABSTRACT. We present the Systemic Console, a new all-in-one, general-purpose software package for the analysis and combined multiparameter fitting of Doppler radial velocity (RV) and transit timing observations. We give an overview of the computational algorithms implemented in the console, and describe the tools offered for streamlining the characterization of planetary systems. We illustrate the capabilities of the package by analyzing an updated radial velocity data set for the HD 128311 planetary system. HD 128311 harbors a pair of planets that appear to be participating in a 2:1 mean motion resonance. We show that the dynamical configuration cannot be fully determined from the current data. We find that if a planetary system like HD 128311 is found to undergo transits, then self-consistent Newtonian fits to combined radial velocity data and a small number of timing measurements of transit midpoints can provide an immediate and vastly improved characterization of the planet’s dynamical state.

Online material: extended table

1. INTRODUCTION

During the past decade, the characterization of extrasolar planets has become a major branch of Astronomy. The field is energized by a variety of ground and space-based detection programs that are meeting with increasing success. In the past year, the census of extrasolar planets has exceeded 300, and planets have now been successfully detected using a variety of techniques, including doppler radial velocity (e.g., Mayor & Queloz 1995; Udry et al. 2007b), transit photometry (e.g., Henry et al. 2000; Charbonneau et al. 2000; 2007), microlensing (Bennett 2009), astrometry (Benedict et al. 2002; Bean & Seifahrt 2009), stellar pulsations (Silvotti et al. 2007) and even direct imaging (Chauvin et al. 2005; Kalas et al. 2008; Marois et al. 2008).

The radial velocity method has been used to discover more than 75% of the known planets, and continues to be a dominant technique, both in terms of its continued productivity (e.g., Fischer et al. 2005) and its ability to accurately probe planetary architectures into the vicinity of the terrestrial mass region (e.g., Rivera et al. 2005; Lovis et al. 2006; Udry et al. 2007a; Bertaux et al. 2009). A number of planets that were initially detected using radial velocity (e.g., HD 209458b, HD 189733b, HD 149026b, Gl 436b, HD 17156b, and HD 80606b) have been later shown to transit as a result of follow-up photometry, and because the parent stars of these planets are bright, follow-up characterizations with a variety of methods have been extremely valuable (e.g., Deming et al. 2005).

The planets that have been detected with the radial velocity technique comprise a complicated and nonuniform sample. Some systems such as Upsilon Andromedae (Butler et al. 1999, 2006), GJ 876 (Marcy et al. 1998, 2001; Rivera et al. 2005), and HD 69830 (Lovis et al. 2006) have had multiple planets subject to very accurate orbital characterization within uniform, well-sampled data sets. Other systems, for example, Epsilon Eridani (Benedict et al. 2006), draw their support from a variety of observational sources and in some cases have orbital parameters that are significantly uncertain. Indeed, it is difficult to draw a firm boundary between detections that are secure, and those that may be subject to serious revision or even elimination.

In addition to the large amount of observational work that has gone into the detection of extrasolar planets, there is a parallel effort by theorists to explain the emerging distributions of planets within the context of theories of planetary formation and evolution. This work spans a wide variety of bases, but a unifying principle is that much of it depends on the raw data being supplied by the catalog of extrasolar planets, and therein lies a difficulty. Dynamicists have traditionally dealt with planetary orbital elements that are known to exquisite precision. As far back as the eighteenth century, the orbital elements of the solar system planets were known with an accuracy well in excess of our current orbital determinations for extrasolar planets. Theoretical interpretations of the extrasolar planetary data is sometimes made without full account of the highly varying signal-to-noise ratios (S/N) of the data sets that make up the

1 UCO/Lick Observatory, Department of Astronomy and Astrophysics, University of California at Santa Cruz, Santa Cruz, CA 95064
2 Department of Geophysical and Planetary Sciences, California Institute of Technology, Pasadena, CA 91125
3 Department of Terrestrial Magnetism, Carnegie Institution of Washington, Washington, DC 20015
Appendix B an automated pipeline (the systemic collaboration has been established as an effort to solve this problem. The plan for this article is as follows. In § 2, we describe the Systemic Console. In § 3, we show some sample applications of the tools that are incorporated in the console, with a particular emphasis on the planetary system orbiting HD 128311 (Vogt et al. 2005). We show that our current radial velocity data set for this system is insufficient for characterizing the resonant relation between the planets, and we demonstrate, using synthetic data sets, how the inclusion of transit timing data (were transits to be detected) would almost immediately eliminate this degeneracy. As another example of the versatility of the code, we describe in Appendix B an automated pipeline (the systemic “back end”) which runs on top of the same program to create a web application that analyzes data sets and aggregates fits. In § 4, we describe the direction of possible future work with the tools that we have developed, and conclude.

2. THE SYSTEMIC CONSOLE

The Systemic Console is a downloadable software package\(^4\) that provides an intuitive graphical user interface for the fitting of planetary signatures, and an associated suite of dynamical analysis tools (Table 1). It can also be used as a specialized, programmable calculator and run scripts in noninteractive mode to access its library of numerical routines. The program is written in the Java programming language for cross-platform portability.

### 2.1. Radial Velocities

The Systemic Console allows for a choice between two modeling schemes. For the majority of the known extrasolar planetary systems, the planets do not experience significant dynamical interactions during the time range spanned by a set of radial velocity observations. In these cases, the radial velocity variation of the star can be represented as a sum of \( N \) Keplerian orbits, each described by orbital elements (period \( P \), mass \( M \), eccentricity \( e \), mean anomaly \( \tau \), and argument of periastron \( \nu \)).

*Figured Keplers provide an adequate model for nearly all of the planetary systems that have been discovered to date (Appendix A). Kepler’s equation is rapidly solved using a simple iterative scheme, and hence models can be quickly evaluated (see, e.g., Ford 2009 for a discussion of the current state of the art).

There are, however, several exceptions, notably GJ 876 (Rivera et al. 2005), HD 202206 (Correia et al. 2005) and HD 60532 (Laskar & Correia 2009) in which a self-consistent, or Newtonian, fit is required. In these cases, planetary interactions

### TABLE 1: THE SYSTEMIC CONSOLE PACKAGE

<table>
<thead>
<tr>
<th>Name</th>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fitting</td>
<td></td>
<td>Multidimensional local optimization (2.3.2).</td>
</tr>
<tr>
<td>Levenberg-Marquardt</td>
<td>Edit → Polish</td>
<td>Multidimensional global optimization (2.3.3).</td>
</tr>
<tr>
<td>Simulated Annealing</td>
<td>Edit → Simulated annealing</td>
<td>Removes linear trends from the radial velocity data.</td>
</tr>
<tr>
<td>Detrend</td>
<td>Edit → Detrend</td>
<td>Adds transits to the ( \chi^2 ) statistics.</td>
</tr>
<tr>
<td>Transit Fitting</td>
<td>Options → Transit fitting</td>
<td></td>
</tr>
<tr>
<td>Periodograms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lomb-Scargle Periodogram</td>
<td>View → Periodogram</td>
<td>Identifies periodicities in the full RV data set and estimates FAPs.</td>
</tr>
<tr>
<td>Lomb-Scargle Periodogram of residuals</td>
<td>View → Periodogram of residuals</td>
<td>Identifies periodicities in the residual RV data set and estimates FAPs.</td>
</tr>
<tr>
<td>Periodogram of sampling</td>
<td>View → Periodogram of sampling</td>
<td>Identifies spurious periodicity peaks associated with uneven sampling of the radial velocities.</td>
</tr>
<tr>
<td>Uncertainty estimation</td>
<td>View → Bootstrap</td>
<td>Estimates uncertainties using the bootstrap routine; plot and export marginal distributions of orbital parameters (2.4.1).</td>
</tr>
<tr>
<td>Bootstrap</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Markov Chain Monte Carlo</td>
<td>View → Markov Chain Monte Carlo</td>
<td>Estimates uncertainties using the MCMC routine; check chain convergence; plot and export marginal distributions of orbital parameters (2.4.2).</td>
</tr>
<tr>
<td>( F )-test</td>
<td>View → ( F )-test, ( F )-test significance</td>
<td>Tracks the fully integrated evolution of the orbital elements and the stability of the system.</td>
</tr>
<tr>
<td>Dynamical analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamical evolution</td>
<td>View → Orbital evolution and stability</td>
<td>Calculates the distribution of central transit times for a given observational window.</td>
</tr>
<tr>
<td>Transits prediction</td>
<td>View → Transits prediction</td>
<td></td>
</tr>
</tbody>
</table>

are taken into account in the fit, and the Console adopts an
$N$-planet model of the system

$$ \frac{d^2 \mathbf{x}_i}{dt^2} = -\sum_{j=1}^{N} \frac{GM_j (\mathbf{x}_i - \mathbf{x}_j)}{|\mathbf{x}_i - \mathbf{x}_j|^3}, \tag{1} $$

with the integrations carried out using either fourth/fifth order
Runge-Kutta with adaptive timestep control or Hermite fourth-
order integration (Press et al. 1992; Hut et al. 1995). When an
integrated model is adopted, a system is defined by the osculating
orbital elements of the planets at the epoch of the first
observation expressed in Jacobi coordinates (see Lee & Peale
2002). The user also has the option of providing an integration
routine.

Finally, the Console allows the velocity offsets between
different data sources to be additional free parameters; this
allows sources with different zero-point offsets (e.g., radial ve-
locity surveys using different templates) to be combined in the
fitting procedure.

The Console carries out parameter minimization of the so-
called reduced chi-square statistic

$$ \chi^2_{\text{RV}} = \frac{1}{N_{\text{RV}} - M_{\text{fit}}} \sum_{i=1}^{N_{\text{RV}}} \left[ \frac{v_i - \nu(x_i; a_1 \ldots a_M)}{\sigma_i} \right]^2, \tag{2} $$

of a fit; in equation (2), $N$ is the number of radial velocity data
points, and $M_{\text{fit}}$ is the number of activated parameters, $a_1 \ldots a_M$.
As a rule of thumb, a reduced chi-square value near unity is
indicative of a “good” fit to the data, suggesting that the model
is a reasonable explanation of the data within the observational
erors. Typically, larger values usually signal an insufficient
modeling of the data, whereas smaller values imply that the data
has been overfit. However, this rule is not exact, and should
hence be applied with caution.

### 2.2. Transits

A rapidly growing number of planets (58 as of writing) with
a favorably inclined orbital plane are being further characterized
with transit timing data\(^5\). Transits enable direct estimations
of planetary masses, radii, and mean densities, together with
period and phase of the transiting planet (Charbonneau et al.
2007). Considerable current interest is focused on detection of
transit timing variations (TTVs) which can point to the presence
of additional perturbing bodies in a given system.

When supplied to the Console, transit data (central primary
and secondary transits timing) is included with the RV data in
the following way. The Console searches for the best-fit orbital
parameters by minimizing over the joint $\chi^2$ statistic

$$ \chi^2 = \frac{1}{N_{\text{RV}} + N_{\text{tr}} - M_{\text{fit}}} \left[ (N_{\text{RV}} - M_{\text{fit}}) \chi^2_{\text{RV}} + \chi^2_{\text{tr}} \right], \tag{3} $$

where $\chi^2_{\text{RV}}$ represents the goodness of fit for the radial velocity
component of the model, as described in § 2.1, and $\chi^2_{\text{tr}}$ is re-
representative of the transit component. Ideally, one would fit to-
gather all of the radial velocity and transit photometry data
with a single model to jointly invert for the parameters that
describe all available data. In the future, these capabilities will
be incorporated into the Console. Much progress can still be
made, however, by restricting our analysis to observed times
of central transit with error bars obtained from separate light-
curve analyses. These transit time data can then act as separate
constraints on the observed behavior of the system. To ease im-
plementation, we compare the predicted and observed location
of the planet at the observed time of central transit, rather than
comparing transit times. Since the orbital velocities are not
changing significantly with respect to the duration of the
eclipse, the difference between these approaches is negligible.
We thus use the following equation to define the goodness-of-fit statistic for the transit component of the model

$$ \chi^2_{\text{tr}} = \sum_{i=1}^{N_{\text{tr}}} \left[ \frac{\delta x_i}{\sigma_{x,i}} \right]^2, \tag{4} $$

where $\delta x_i$ is the predicted separation perpendicular to the line of
sight at the observed central transits $t_i$, such that

$$ \delta x_i = \left| x_i(t_i) - x_P(t_i) \right|, \quad i = 1 \ldots N. \tag{5} $$

The error on $\delta x_i$ is estimated from the error on $t_i$ as $\sigma_{x,i} = v_{x,P} \sigma_t$. While we do not explore it here, it is important to
recognize that regularization of the fit may be warranted in this
type of analysis (Press et al. 1992).\(^5\)

Since it is routinely possible to achieve small error bars on
the central primary transits (100 s for ground-based observations
down to 10 s for HST observations), a best fit found by the
Console that includes transit timing may yield extremely
precise determinations of the period and mean anomaly at epoch
of the transiting planet (e.g., Wittenmyer et al. 2005; Bean
et al. 2008).

Detection of central secondary eclipses (Deming et al. 2007)
also places tight bounds on the eccentricity and argument of
periastron of the planet. This additional constraint can break de-
generacies present when RVs alone are used; for instance, it can

\(^5\)Regularization is a formal statistical method of compromising between two
distinct sources of information. This is accomplished by adding a relative
weighting factor $\lambda$ in front of one of the components of the overall $\chi^2$ metric,
where the value of $\lambda$ determines the relative importance of the two components
of the goodness of fit. There are many different methods that can be used to
choose an appropriate value for the weighting factor. In this work, we have im-
plcitly chosen the value $\lambda = 1$, corresponding to an equal weighting.
discriminate between eccentric single-planet systems and two-planet systems in a 2:1 resonance with circular orbits (Anglada-Escude et al. 2008).

Further afield, it can be possible to measure transit timing variations (TTV) in a dynamically interacting planetary configuration and infer the orbital elements of a perturbing, non-transiting body (Holman & Murray 2005; Agol et al. 2005; Agol & Steffen 2007).

2.3. Best-fit Model Estimation

2.3.1. Periodograms and False Alarm Probabilities

The Lomb-Scargle (LS) periodogram is an algorithm for time-series analysis of unevenly spaced data (Scargle 1982; Horne & Baliunas 1986; Press et al. 1992). The LS periodogram is useful for rapidly identifying periodic signals in the observed data, and to residuals to a given fit, without having to fit for the other orbital parameters. The formula for an error-weighted periodogram \( P_x(\omega) \) as implemented in the Console is given in Gilliland & Baliunas (1987); the individual weights are taken to be \( w_i = 1/\sigma_i^2 \).

An advantage of this method is that its statistical properties are well known and are conducive to the definition of an analytic false alarm probability (FAP) associated with each periodic signal. When the periodogram is normalized by the total variance \( P_0(\omega) = P_x(\omega)/\sigma^2 \), the estimated probability that a peak as high or higher would occur by chance is given by \( \text{Pr}(p_0,N_f) = 1 - [1 - \text{exp}(-p_0)]^{N_f} \), where \( N_f \) is the effective number of frequencies.

Finally, since the unequal spacing of the data can be a source of spurious periodicities (e.g., those associated with the synodic lunar month or yearly observational schedules), the Console also supports plotting of the power spectral window (Deeming 1975) overlaid over the standard (non-error-weighted) periodogram.

2.3.2. Levenberg-Marquardt (local minimization)

Given the observations and associated errors, the goal is to obtain a model configuration \( y_m \) (a \( 5N \) vector of orbital parameters) such that \( \chi^2(y_m) = \min \chi^2 \); this is usually reported as the “best-fit” solution. Typically, the Lomb-Scargle periodogram is used to comb through periodicities in the data; periodicities are removed in order of decreasing half-amplitude \( K \) and optimized using line-minimization. This procedure leads to a set of orbital parameters \( y_\alpha \) which is a rough approximation to the best-fit solution, and can be improved with simultaneous multiparameter minimization. For a discussion of the intricacies of the Keplerian fitting process, see Cumming et al. (2008).

Multidimensional parameter minimization can be carried out using the Levenberg-Marquardt algorithm (LM; Press et al. 1992). Given the initial guess \( y_\alpha \), the LM algorithm can quickly converge to a local minimum \( y^* \). Good convergence of the LM algorithm is conditional on the choice of the initial guess and a favorable geometry of the \( \chi^2(y) \) surface: in particular, the algorithm is sensitive to rugged \( \chi^2 \) surfaces and can be prone to converging to nonoptimal minima.

2.3.3. Simulated Annealing (global minimization)

So-called “global” minimization techniques attempt to avoid getting trapped in local minima by adding a degree of randomness at each iteration step, although at a much greater computational cost. Simulated annealing (SA; Press et al. 1992), by analogy to several thermodynamic processes in nature, defines an “energy” \( E \) as the objective function to minimize and allows for temperature fluctuations between states at different energies as dictated by the current temperature \( T_n \); the temperature \( T_n \) is lowered with a (problem-dependent) scheduler. This algorithm is particularly appropriate for rugged \( \chi^2 \) surfaces, or when the initial guess is sufficiently distant from the best-fit solution.

In our problem, the objective function is clearly \( \chi^2(y) \). Given a state \( y_n \), the algorithm selects a new configuration \( y_{n+1} \); the new configuration is accepted and kept with a probability \( P(n \rightarrow n + 1) \sim \exp(-\Delta E/T_n) \) if \( E_{n+1} > E_n \), and is always accepted if \( E_{n+1} < E_n \) (a downhill step). The temperature is subsequently updated according to the input scheduler, and the process is repeated until a target number of steps \( N \) is reached. The fact that uphill steps are sometimes accepted (according to the current temperature) lets the algorithm explore a larger portion of the parameter space and makes it less likely to get stuck in a narrow local minimum. The trial configuration \( y_{n+1} \) is selected using a proposal distribution, which is an easily evaluated generator of trial configurations that picks a new set of parameters given the current set of parameters. The default function is a multivariate Gaussian distribution centered on the current step \( y_n \); the variance \( \beta_\mu \) can be chosen independently for each parameter.

The algorithm requires that the following are configured from the user:

1. Temperature scheduler: The default scheduler decreases \( T \) according to \( T_n = T_0(1 - n/N)^\alpha \), where \( T_0 \) and \( \alpha \) are input parameters that dictate the initial temperature and cooling rate. The optimal values of \( T_0 \) and \( \alpha \) are problem dependent and quite often may determine whether the routine successfully recovers the true global minimum.

2. Generator of trial configurations: The default generator is a Gaussian function centered around the current configuration, with the scale parameter vector \( \beta_\mu \) given by the user (an initial value is suggested).

Since the correct recovery of \( y_m \) depends on appropriate choices of \( T_0, \alpha, N, \) and \( \beta_\mu \) that are not known a priori, the Console allows several SA jobs to run in parallel, improving the chance of convergence to the best-fit model. Reconfigurations, in the form of occasionally jump-starting the routine with the best-ever solution, can also be beneficial to the success of the algorithm.
Other global minimization schemes, such as genetic algorithms (e.g., Charbonneau 1995; Laughlin & Chambers 2001), are being considered for inclusion in the Console’s built-in array of tools. They can be easily implemented by the user using the routine library offered by the Console.

Finally, we note that certain planetary systems such as HD 80606 (Laughlin et al. 2009; Gillon 2009; Pont et al. 2009) include both photometric and spectroscopic data, and contain planets with high orbital eccentricities. In these cases, the connection between observable quantities and the orbital and physical parameters is highly nonlinear, and a modeling framework that relies purely on \( \chi^2 \) minimization may have a difficult time recovering the correct system configuration. Future releases of the console will therefore incorporate the option of using a fully Bayesian approach to the fitting problem.

### 2.4. Error estimation

Radial-velocity searches are constantly pushing the envelope toward lower and lower masses, frequently at the threshold of detection, with low S/N. For this reason, once the best-fit parameters have been identified, it is vital to rigorously characterize their uncertainty. The Console offers two independent methods for estimating uncertainty: synthetic data sets refitting (bootstrap) and Markov Chain Monte Carlo (MCMC).

#### 2.4.1. Bootstrap

The bootstrap procedure consists of drawing with replacement from the observed data points (RV and central transits) and creating a number of synthetic data sets \( \mathcal{A}_{i=1,N} \). The LM fitting procedure is then applied to each data set, using the best-fit solution for the real data set as the initial guess. The distribution of the obtained fitted parameters \( \mathbf{y}_{i=1,N} \) yield an estimated \( \sigma \) for the scatter of the orbital elements around the true intrinsic orbital parameters.

The bootstrap algorithm is well known (Press et al. 1992) and in common use for estimating planetary elements uncertainties, but it presents a number of disadvantages; namely, that it drives a local minimization routine (and is thus subject to the same pitfalls), and that it has a large computational burden. To partially improve on the first weakness, bootstrap can optionally be preceded by a burn-in phase. The burn-in phase obtains a rough estimate of the scatter in the parameters by running a short bootstrap phase. The error estimate is then used in the actual bootstrap run to perturb the best fit a set number of times (e.g., 10 times) per each synthetic data set fitting; only the best-fitting final configuration is retained. This helps to improve the reliability of the bootstrap routine in some cases.

#### 2.4.2. Markov Chain Monte Carlo

Markov Chain Monte Carlo (see, e.g., Ford 2005; Gregory 2005b for exoplanet-related implementations) is an alternative method for estimating uncertainties that does not rely on minimization schemes. The MCMC method generates a sequence (chain) of configurations \( \mathbf{y} \), that is sampled from the (unknown) probability distribution \( f(\mathbf{y}) \). The transition probability between two subsequent configurations \( \mathbf{y}_n \) and \( \mathbf{y}_{n+1} \) is

\[
\alpha(\mathbf{y}_{n+1}|\mathbf{y}_n) = \min\left(1, \exp\left(\frac{\chi_n^2 - \chi_{n+1}^2}{2}\right)\right). \tag{6}
\]

Assuming that the observational errors are accurately estimated and approximately Gaussian, this transition function assures that, after discarding an initial burn-in phase, the distribution of generated configurations will be sampled from the unknown probability distribution \( f \).

The algorithm consists of looping over the following steps, given an initial state \( \mathbf{y}_0 \):

1. Given a state \( \mathbf{y}_n \) and a Gaussian generator of trial states with scale parameters \( \beta_n \) (see 2.3.3), generate a trial state \( \mathbf{y}' \);
2. Accept the trial state \( \mathbf{y}' \) with a probability \( \alpha(\mathbf{y}'|\mathbf{y}_n) \) and set \( \mathbf{y}_{n+1} = \mathbf{y}' \), otherwise discard it (downhill steps are again always accepted);
3. Set \( n = n + 1 \);

until some convergence criterion of the chain is satisfied. The MCMC algorithm guarantees convergence to the true distribution \( f(\mathbf{y}) \), but can explore the parameter space inefficiently depending on the choice of \( \beta_n \), or may not achieve satisfactory convergence within the chosen \( N \) steps. The convergence can be visually monitored by interactive plotting of the marginal distribution of the parameters. The acceptance rate of the MCMC algorithm can be interactively monitored as well; an optimal acceptance rate is \( \sim 0.25 \) (Gelman et al. 2003).

As with simulated annealing, multiple MCMC chains can be generated in parallel to provide comparison between the results obtained with different choices of \( \beta_n \) and chain length, which yield similar results within statistical uncertainties if all chains have converged. More sophisticated Bayesian algorithms, such as parallel tempering MCMC (Gregory 2005a), may be implemented by the user by exploiting the programmable interface of the Console.

### 3. APPLICATIONS

#### 3.1. Resonance Characterization in the HD 128311 System

A high fraction of the detected extrasolar systems with multiple planets are involved in near-low-order mean-motion resonances (MMRs), with at least four of them (GJ 876, HD 82943, HD 73526, and HD 128311) being reported to engage in strong 2:1 resonances. Two planets are in a mean-motion resonance when the periods are in a ratio of small integers, and at least one of the resonant angles librates (i.e., it spans a range smaller than \( 2\pi \)). Resonant angles are linear combinations of \( \varpi \) (argument of periastron) and \( \lambda = M + \varpi \) (coplanarity is
assumed). The relevant resonant angles for a 2:1 resonance are \( \theta_1 = 2\lambda_2 - \lambda_1 - \omega_2 \) and \( \Delta \omega = \omega_2 - \omega_1 \) (Murray & Dermott 2000).

Radial velocity measurements for HD 128311 (Vogt et al. 2005) indicated that the system is locked in a 2:1 MMR, which ensures the long-term stability of the two giant planets. The best-fitting model was indefinitely stable, with the resonant argument \( \theta_1 \), librating with a half amplitude of about 60 degrees; a naive fit using Keplerian ellipses instead of the full N-body model is catastrophically unstable within about 2000 years. Orbital fits for the systems generated using a Monte Carlo procedure (similar to § 2.4.1) yielded a proportion of about 60% stable systems with \( \theta_1 \) librating and \( \Delta \omega \) circulating to about 40% with both arguments librating (apsidal corotation). The large stellar jitter (\( \sim 9 \) m s\(^{-1} \)) and the relatively long periods of the two planets implies that models with different resonant configuration are equally likely given the radial velocity data set.

However, whether or not the system is in apsidal corotation is a crucial piece of information, since it can provide fundamental clues to the migration and interaction history of the system. Scenarios of slow migration and resonant capture into a 2:1 MMR (e.g., Nelson & Papaloizou 2002; Lee & Peale 2002; Beaugé et al. 2006) consistently result in systems that are librating in both resonant arguments. Sándor & Kley (2006), analyzing the specific case of HD 128311, showed that after adiabatic migration and capture into MMR, the two planets are in apsidal corotation and have very small libration amplitudes. If a definitive prevalence of model fits not in apsidal corotation were ascertained, then the discrepancy has to be explained in terms of subsequent perturbative events (such as sudden termination of migration or planet-planet scattering) that happen after an adiabatic migration process. Analogous studies have been conducted for GJ 876 (Kley et al. 2005) and HD 73526 (Sándor et al. 2007).

It is therefore important to distinguish between the two resonant configurations (ideally, at the 90% confidence level or better); this requires a more precise determination of the orbital parameters, which might be achieved, for instance, with additional RV measurements.

For this purpose, we present a set of additional Doppler measurements taken between 2005 June and 2008 May using the HIRES spectrometer (Vogt et al. 1994). Doppler measurements are taken using the standard iodine cell technique (see Butler et al. 1996 for more details). Table 2 lists the updated Keck data set, giving the time of each observation, the radial velocity, and the internal uncertainties.

### 3.2. Best Fit

We update the analysis of Vogt et al. (2005) using the tools built into the Console for both the original data and the updated RVs presented in this article. The Console is well suited to this task, since it can easily derive self-consistent fits (interactively) and do batch Monte Carlo dynamical analyses on large sets of orbital parameters (noninteractively).

The two prominent periodicities in the Vogt et al. (2005) data set were found using the integrated Lomb-Scargle periodogram. A self-consistent (Newtonian) best fit was then derived using the Levenberg-Marquardt minimization routine; one of the built-in N-body integrators (Hermite) was used to derive the radial velocity curve for each choice of orbital parameters. The final best-fit orbital parameters are listed as Fit A (Table 3). The uncertainties for each orbital parameter are found using the bootstrap routine on 10,000 synthetic data set realizations.

Subsequently, we derived the best fit for the full updated Keck data (Table 2), together with the observations taken with the Hobby-Eberly Telescope (HET) and reported in Wittenmyer et al. (2009), the Lomb-Scargle periodogram and the associated analytic FAP estimates are shown in Figure 1. The Console can

### TABLE 2

<table>
<thead>
<tr>
<th>JD</th>
<th>RV (m s(^{-1}))</th>
<th>Uncertainty (m s(^{-1}))</th>
</tr>
</thead>
<tbody>
<tr>
<td>2450983.82690</td>
<td>-12.95</td>
<td>1.45</td>
</tr>
<tr>
<td>2451200.13787</td>
<td>-21.49</td>
<td>1.92</td>
</tr>
<tr>
<td>2451342.85836</td>
<td>62.75</td>
<td>2.05</td>
</tr>
<tr>
<td>2451370.82904</td>
<td>105.66</td>
<td>1.88</td>
</tr>
<tr>
<td>2451409.74660</td>
<td>125.71</td>
<td>1.62</td>
</tr>
<tr>
<td>2451410.74909</td>
<td>118.14</td>
<td>2.01</td>
</tr>
<tr>
<td>2451552.16457</td>
<td>68.78</td>
<td>1.85</td>
</tr>
<tr>
<td>2451581.17009</td>
<td>13.35</td>
<td>1.64</td>
</tr>
<tr>
<td>2451680.02544</td>
<td>-60.10</td>
<td>2.17</td>
</tr>
<tr>
<td>2451974.16142</td>
<td>62.03</td>
<td>1.74</td>
</tr>
</tbody>
</table>

Note.—Table 2 is published in its entirety in the electronic edition of the PASP. A portion is shown here for guidance regarding its form and content.

### TABLE 3

<table>
<thead>
<tr>
<th>Fit A</th>
<th>Fit B</th>
<th>Fit C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period (days)</td>
<td>466.6 [7.5]</td>
<td>469.1 [3.3]</td>
</tr>
<tr>
<td>Mass (M(_J))</td>
<td>909.5 [21.0]</td>
<td>893.5 [6.2]</td>
</tr>
<tr>
<td>Mean anomaly (deg)</td>
<td>1.59 [0.22]</td>
<td>1.79 [0.17]</td>
</tr>
<tr>
<td>Eccentricity</td>
<td>3.19 [0.11]</td>
<td>3.19 [0.08]</td>
</tr>
<tr>
<td>Mean anomaly (deg)</td>
<td>270.6 [31.9]</td>
<td>282.2 [16.8]</td>
</tr>
<tr>
<td>Long. of periastron (deg)</td>
<td>192.0 [23.3]</td>
<td>190.0 [13.7]</td>
</tr>
</tbody>
</table>

Note.—Fit A: integrated best fit to the Vogt et al. (2005) Keck RV data. Fit B: integrated best fit to the updated RV data reported in this article and the HET data reported in Wittenmyer et al. (2009). Fit C: orbital elements used to generate the synthetic data sets. All elements are defined at epoch JD = 2450983.8269. Uncertainties are reported in brackets.

2009 PASP, 121:1016–1027
account for the zero-point offset and the velocity offset between the two data sets as two additional free parameters. The Newtonian best-fit orbital parameters derived, however, result in a system that is unstable within 1000 years. Therefore, we generated a pool of alternative 5000 bootstrap-generated trial fits, checked each of them for stability within 10,000 years, and selected the best-fitting stable solution. Its orbital parameters and corresponding uncertainties are listed as Fit B (Table 3). This model is protected by a 2:1 MMR, in which $\theta_1$ librates with amplitude $\sim 60$ deg and $\Delta \varpi$ circulates. The radial velocity measurements and the star radial velocity curve are shown in Figure 2.

3.3. Dynamical Interactions

Following the procedure detailed in Vogt et al. (2005), we took the two self-consistent two-planet fits (Fit A and Fit B) and applied a Monte Carlo bootstrap procedure, in which new fits are derived by resampling, with replacements, the radial velocity data sets. We created two Monte Carlo-generated libraries of 5000 self-consistent models for two radial velocities data sets: the radial velocities listed in Vogt et al. (2005) and the updated Keck data reported in Table 2. For each of the two groups, 800 fits, stable for at least $10^4$ years$^7$, were selected and integrated forward, recording the maximum eccentricity.

$^7$ For longer-term integrations, the built-in integration schemes (RK45 and fourth order Hermite) might not be sufficiently accurate and can be substituted by integration schemes supplied by the user. Alternatively, the Console can be set up to drive packages such as SWIFT (http://www.boulder.swri.edu/~hal/swift.html) or Mercury (Chambers & Migliorini 1997).

Fig. 1.—Lomb-Scargle periodogram for the combined Keck and HET data sets, as plotted by the Console. Analytical FAPs at levels $10^{-1}$ (long dashed), $10^{-2}$ (short dashed) and $10^{-3}$ (dotted) are overlaid.

Fig. 2.—Best-fit integrated solution to the RV data presented in this article (blue) and the HET data (green) reported by Wittenmyer et al. (2009; orbital parameters listed as Fit B in Table 3).
for both planets and the amplitude of libration of both resonant angles. The results of this analysis are shown in Figure 3.

With the new radial velocity data, the percentage of model fits that are stable and in apsidal corotation using the additional RVs falls slightly, to 20%. A different run considering 1600 models also yields a similar percentage, confirming that the result is robust. The inclusion of the HET data also does not change our result significantly (Table 2). Therefore, while we have strengthened the case for models of HD 128311 that only librate in $\theta_1$, a secure determination of the libration amplitude of $\Delta \varpi$ might be obtained either by a transit monitoring campaign or yet additional RV measurements.

3.4. Constraints by Transits

Although the a priori geometric probability for transits $P_{tr}$

$$P_{tr} = 0.0045 \left( \frac{1 \text{ AU}}{a} \right) \left( \frac{R_+ + R_{pl}}{R_\odot} \right) \left[ \frac{1 - e \cos(\frac{\pi}{2} - \varpi)}{1 - e^2} \right]$$

(Bodenheimer et al. 2003) is very low for HD 128311b ($P_{tr} \approx 0.0032$), given the high precision that can be achieved by the addition of transits to the $\chi^2$ budget, it is a worthwhile exercise as a proof of concept. Moreover, other resonant systems have higher transiting probabilities; for instance, planets

![Graphs showing maximum eccentricities observed during 10^4 yr integrations of self-consistent models obtained using the bootstrap routine for data from Vogt et al. (2005) (top left), data presented in this article (top right) and synthetic data (bottom). Filled circles: scenarios in which both arguments librate. Open circles: scenarios in which $\theta_1$ librates and $\Delta \varpi$ circulates. Gray squares: scenarios in which both arguments circulate. In the bottom panel, black and blue symbols are for models derived considering RV data only, whereas red symbols are for models considering RV and transits.](image)
GJ 876b and c have a priori transit probabilities \( \sim 1\% \), though the inclination of the system is unfavorable and no transits have been observed (Shankland et al. 2006).

We selected the best-fitting solution in apsidal corotation from the ensemble of systems generated by Monte Carlo bootstrapping of the RVs presented in Table 2 (Fit C). The orbital elements are listed in Table 3. Subsequently, we created a synthetic data set of RVs and transits by integrating forward in time, using the \( N \)-body routines offered by the Console. The RVs are generated by sampling the radial velocity curve at the times listed in Table 2; the tabulated uncertainties and a jitter of 9 m s\(^{-1} \) are added to the measurement. The central transit times data set comprises four points, to which we added a Gaussian noise with amplitude \( 10^{-4} \) days (comparable to the uncertainties that can be achieved by ground-based transit observations; e.g., Alonso et al. 2008).

We repeated the analysis detailed in the previous section by bootstrapping exclusively the RV data (Table 4); this yields similar ratios, shifted to favor systems in apsidal corotation (similarly to the generating fit).

As expected, the inclusion of the four central transit times largely reduces the parameter space that can be spanned by Monte Carlo explorations. The large excursions in \( \chi^2 \) and the increased ruggedness of the \( \chi^2 \) space makes the simple bootstrapping algorithm, driving a Levenberg-Marquardt scheme, somewhat inefficient in fully exploring the allowed space of orbital parameters (as anticipated in § 2.4.1). We therefore used the Markov Chain Monte Carlo routine supplied with the Console. A long chain of systems \( (5 \times 10^5) \) was generated; the first 50,000 systems were discarded and only 1 in every 100 systems were retained, to minimize the correlation between subsequent chain elements.

The tightness of the orbital parameter uncertainties thus generated \( \sim \Delta P_1/P_1 = 2.1 \times 10^{-6}; \Delta P_2/P_2 = 3 \times 10^{-6} \) d; \( \Delta M_1/M_1 = 1.4 \times 10^{-3}; \Delta M_2/M_2 = 4.2 \times 10^{-4}; \Delta \varpi_1 = 2.4 \times 10^{-3}; \Delta \varpi_2 = 1.3 \times 10^{-3} \) anticipates that the ratio of correctly recovered resonant configuration will be very high. In fact, with the addition of the four primary transits, all of the systems are correctly identified in apsidal corotation (Table 4).

The maximum eccentricities achieved by the two planets (Fig. 3) are determined within \( 10^{-3} \).

### 4. DISCUSSION

In this article, we have described the features of the Systemic software package. This software has been written with extensibility, portability, and clarity as guiding principles, and is fully adequate for all but the most demanding exoplanet-related analysis tasks. The Console provides a uniform method for analyzing data stemming from a variety of sources (radial velocities, surveys and transits) and allows the efficient recovery of the best-fitting stable planetary configuration, even in presence of strong mutual perturbations. It is provided for free to the scientific community.

As an example of an application, we have analyzed an updated radial velocity data set for the pair of resonating planets harbored by HD 128311. As first noted by Vogt et al. (2005), the orbital solution to this system is degenerate between apsidally corotating and nonapsidally corotating fits; the additional data sets do not break the degeneracy, owing to the large stellar jitter and long orbital periods. We have used an analysis of synthetic data sets to demonstrate that the detection of a transiting extrasolar planet system with planets participating in a low-order mean-motion resonance, such as HD 128311, would lead to a rapid determination of the libration widths of the resonant arguments and an attendant understanding in how such systems form and evolve. Additionally, our analysis shows that the parameters of nontransiting planets can be very well constrained through transit timing variations in presence of strong mutual interactions. As noted in § 2.2, however, a more detailed analysis may be warranted (in particular regarding the issues of fit regularization and full photometry fitting) and will be the object of a follow-up paper. Finally, we showed that breaking the degeneracy at a comparable level with radial velocities would require a prolonged observation campaign, of 30 years or more.

We plan to improve the current feature set of the Console by (1) adding facilities for fully fitting the raw light curve data of a transit detection, (2) implementing more sophisticated routines for best-fit parameter and uncertainty estimation, and (3) allowing non-coplanar, inclined fits. We note that to date, nearly all of the planetary systems that have been detected with the Doppler radial velocity technique can be satisfactorily modeled (to the precision of the observations) using coplanar models with the inclinations assumed to be 90°. The Console’s integration routines and internal system representations are fully threedimensional, however, and so a forthcoming version will enable non-coplanar fits and will accept astrometric measurements.

---

**Table 4: Monte Carlo Analysis Results**

<table>
<thead>
<tr>
<th>Data</th>
<th>R2 (%)</th>
<th>R1 (%)</th>
<th>NR (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005 (76 Keck RVs)</td>
<td>281</td>
<td>489</td>
<td>30</td>
</tr>
<tr>
<td>2008 (102 Keck RVs)</td>
<td>160</td>
<td>618</td>
<td>22</td>
</tr>
<tr>
<td>2008 (102 Keck + 78 HET RVs)</td>
<td>180</td>
<td>615</td>
<td>5</td>
</tr>
<tr>
<td>Fit C, 102 RVs</td>
<td>603</td>
<td>197</td>
<td>0</td>
</tr>
<tr>
<td>Fit C, 102 RVs + 4 transits</td>
<td>800</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Fit C, 306 RVs</td>
<td>743</td>
<td>52</td>
<td>5</td>
</tr>
</tbody>
</table>

**Note:** R2: resonant fits with both arguments librating. R1: resonant fits with \( \theta_1 \) librating and \( \Delta \varpi \) circulating. NR: fits have both arguments circulating.

As a comparison, we ran the same procedure against 204 additional RVs (a 30 year observation stretch), derived by sampling the integrated stellar radial velocity with the same schedule used for the Keck data set. This large amount of additional RVs is required to identify the generating planetary system as apsidally corotating with a fraction >90% of models (Table 4).
(e.g., Bean & Seifahrt 2009). With the advent of space missions such as SIM Lite and Gaia, there will be numerous opportunities to accurately discern the three-dimensional orbital configurations of many nearby planetary systems (Unwin et al. 2008). Finally, signatures of less obvious effects in the spectroscopic and photometric data sets, such as those expected from general relativity (Wu & Goldreich 2002) or the excitation of tidal modes in the host star (Wu & Murray 2003), will require more sophisticated modeling to be properly taken into account.

We would like to thank the participants in the systemic project for contributing a large amount of research effort toward the characterization of extrasolar planets. The results reported in this article would not have been possible without their dedicated participation. We are grateful to Debra Fischer, Eric Ford, Man Hoi Lee, Doug Lin, and Peter Jalowiczor for useful discussions, and the anonymous referee for a very thorough evaluation of the paper and several valuable suggestions.

This research has been supported by the NSF through CAREER Grant AST-0449986, and by the NASA Astrobiology Institute through Grant NNG04GK19G. The Console software package may be downloaded for free at http://www.oklo.org.

REFERENCES

Bennett, D. P. 2009, ArXiv e-prints
Chambers, J., & Migliorini, F. 1997, BAAS, 29, 1024
———. 2009, New Astron., 14, 406


APPENDIX A

SUMMED KEPLERIANS MODEL

When the perturbations between planets are negligible over the observational window, it is appropriate to model the radial velocity curve as a superposition of $N$ Keplerian orbits of fixed orbital elements

$$v_r(t) = \sum_{i=1}^{N} K_i [\cos(v_i + \omega_i) + e_i \cos \omega_i], \quad (A1)$$

where the radial velocity half-amplitude, $K_i$, of planet $i$ is given by

$$K_i = \left\langle \frac{2\pi G}{P_i} \right\rangle^{1/3} \frac{M_i \sin i_i}{(M_* + M_i)^{2/3}} \frac{1}{\sqrt{1 - e_i^2}}, \quad (A2)$$

and where the true anomaly, $v_i$, is related to the eccentric anomaly, $E_i$, via

$$\tan \frac{v_i}{2} = \sqrt{\frac{1 + e_i}{1 - e_i}} \tan \frac{E_i}{2}. \quad (A3)$$

The eccentric anomaly, $E_i$, in turn, can be expressed in terms of the mean anomaly $M_i = 2\pi / P_i (t - T_{peri})$ through Kepler’s equation

$$M_i = E_i - e_i \sin E_i \quad (A4)$$

(Murray & Dermott 2000).

APPENDIX B

THE SYSTEMIC BACK END

The systemic back end is a web application that showcases the power of the Console as an automated engine for data analysis. It consists of a database of catalog information (stellar properties as well as RV and transit measurements) as published in the astronomical literature, and a catalog of model planetary fits for each star. For this purpose, it uses the Console as its main engine to perform a number of automatic data explorations, whereas the user-facing part uses standard “Web 2.0” tools (PHP, MySQL, Javascript, and wikis) to present a coherent overview of the data. A public back end is available as a proof of concept to foster collaboration within the broader community of exoplanet researchers and enthusiasts, and to present and maintain the catalog of fits to radial velocity and transit timing data for known planet-bearing stars. Each user has a personal data page and fit catalog, and the options of commenting on other team member’s fits and interacting with other team members within a private and secure environment. A more powerful and customizable version is also available on request for use by planet hunter teams, and can be useful to maintain an integrated database of data sets and models in face of the increasing flux of RV and transit data.

The fit catalog is scanned by a number of Console components, which continually sift through the uploaded fits in

The publicly accessible version is available at http://207.111.201.70/php/backend.php.
noninteractive mode. One component implements a bootstrap routine to calculate uncertainties on the orbital parameters of each fit; data from the bootstrap routine are stored in a database for creating scatter plots. Two other components check for dynamical instability over periods of 1000 and 10,000 yr, with stability defined by the rough criterion of requiring a smaller than 1% fractional change in semimajor axis with respect to the average semimajor axis observed during a full \( N \)-body integration. This step flags highly unstable planetary systems that experience ejections or collisions. Data from the integration is retained for plotting of orbital evolution and for future additional investigations. Dynamical data (orbital parameters, radial velocity data, fit parameters, stability, integrations, bootstrap results) are then transparently presented to the user as a set of web pages and can be aggregated and sliced using a web-based query system.